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Preface

These release notes contain information relevant to the Sun Java™ Desktop System
Release 2. Read this document before you install the Java Desktop System.

Related Documentation
The following manuals are related to this guide:

� Java Desktop System Release 2 Installation Guide
� Java Desktop System Release 2 Quick Start User Guide
� Java Desktop System Release 2 Troubleshooting Guide
� Java System Update Service User’s Guide

Associated Documentation
The following documents are associated with this guide:

� GNOME 2.2 Desktop Accessibility Guide
� GNOME 2.2 Desktop on Linux System Administration Guide
� GNOME 2.2 Desktop on Linux User Guide
� StarOffice 7 Office Suite Administration Guide
� StarOffice 7 Office Suite Basic Guide
� StarOffice 7 Office Suite Setup Guide
� StarOffice 7 Office Suite User’s Guide
� Ximian Evolution 1.4 Sun Microsystems Edition User Guide
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Accessing Sun Documentation Online
The docs.sun.comSM Web site enables you to access Sun technical documentation
online. You can browse the docs.sun.com archive or search for a specific book title or
subject. The URL is http://docs.sun.com.

Ordering Sun Documentation
Sun Microsystems offers select product documentation in print. For a list of
documents and how to order them, see “Buy printed documentation” at
http://docs.sun.com.

Typographic Conventions
The following table describes the typographic changes that are used in this book.

TABLE P–1 Typographic Conventions

Typeface or Symbol Meaning Example

AaBbCc123 The names of commands, files, and
directories, and onscreen computer
output

Edit your .login file.

Use ls -a to list all files.

machine_name% you have
mail.

AaBbCc123 What you type, contrasted with onscreen
computer output

machine_name% su

Password:

AaBbCc123 Command-line placeholder: replace with
a real name or value

The command to remove a file
is rm filename.

AaBbCc123 Book titles, new terms or terms to be
emphasized

Read Chapter 6 in the User’s
Guide.

These are called class options.

Do not save the file.
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Shell Prompts in Command Examples
The following table shows the default system prompt and superuser prompt for the C
shell, Bourne shell, and Korn shell.

TABLE P–2 Shell Prompts

Shell Prompt

C shell prompt machine_name%

C shell superuser prompt machine_name#

Bourne shell and Korn shell prompt $

Bourne shell and Korn shell superuser prompt #
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Java Desktop System Release 2 Release
Notes

The Java™ Desktop System Release 2 offers a complete desktop environment that is
largely based on open source software.

� “Contents of This Release” on page 9
� “Known Issues” on page 10
� “Where To Find Documentation” on page 11
� “Plugins for Mozilla 1.4” on page 13
� “Ximian Evolution 1.4 FAQ” on page 14
� “Migration To Unicode Multilingual Computing” on page 16
� “Supported Languages” on page 19
� “Unsupported Applications” on page 20
� “Unsupported Third Party Applications” on page 21
� “Unsupported Games” on page 21
� “Product Updates” on page 22
� “Customer Support” on page 22

For the latest version of these release notes, see http://docs.sun.com.

Contents of This Release
The contents of this release of the Java Desktop System are shown in Table 1–1.

TABLE 1–1 CD Contents

CD Description

CD1, CD2, CD3 Contain all the files you need to install the
Java Desktop System.
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TABLE 1–1 CD Contents (Continued)
CD Description

CD4, CD5 Contain the sources for the contents of CD1,
CD2 and CD3. You do not need CD4 and CD5
during the installation process.

Documentation CD Contains the user documentation for the Java
Desktop System.

Known Issues
See the Java Desktop System Release 2 Troubleshooting Guide for known issues and
workarounds. The following table describes known issues for which a workaround
has not yet been identified.

Topic Known Issue

About
GNOME

Bug ID: 5025654

The About GNOME dialog contains incorrect version information.

File Manager Bug ID: 5021163

The Nautilus file manager cannot inherit permissions via nfs:///. As a
result, you cannot change permissions for files and folders on an nfs mount.
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Topic Known Issue

Localization � This release of the Java Desktop System includes many localized versions
of applications that are taken from the GNOME community. Sun
Microsystems does not take any responsibility for the completeness or
accuracy of these localizations.

� You cannot print out documents from Mozilla containing non-BMP
Unicode characters.

� This release of the Java Desktop System only supports the HKSCS-1999
version of the Hong Kong Supplementary Character Set (HKSCS), due to
the version of glibc that the system uses. Support for HKSCS-2001 is
planned for a future release of the Java Desktop System. The differences
between HKSCS-1999 and HKSCS-2001 are as follows:
� HKSCS-1999 uses ISO-10646/Unicode PUA (Private Use Area) to

assign code for additional characters defined in HKSCS that were not
part of ISO-10646/Unicode as of 1999, and is not, and will not be an
official part of ISO-10646/Unicode.

� HKSCS-2001 uses ISO-10646/Unicode Plane 2 for the same characters
defined in HKSCS-1999 instead of PUA, because the HKSCS character
repertoire is accepted as an official part of ISO-10646/Unicode.

� HKSCS-2001 supports an additional 116 characters over HKSCS-1999.
Since code assignment between HKSCS-1999 and HKSCS-2001 is different,
although ISO-10646/Unicode with HKSCS-1999 works in this release of
the Java Desktop System, any documents using characters in HKSCS-1999
need code conversion, as if they are written in legacy encodings such as
EUC or Big5, to interchange with the systems using ISO-10646/Unicode
with HKSCS-2001.
The version of glibc that supports HKSCS-2001 is available for download
for this release of the Java Desktop System, together with the HKSCS-1999
to HKSCS-2001 code converter.

� Bug ID: 5025578
When the Korean Input Method is enabled, hot keys do not work for
non-GTK applications.

� Bug ID: 5030768
In the Sun Java Studio 5 Standard Edition for Java Desktop System CD, the
Chinese language Getting Started Guide in the README.html is linked to
the wrong document. The correct link is as follows:
Documentation_zh/getstartedse_zh_CN.pdf

Where To Find Documentation
You can view PDF and HTML versions of the documentation for the Java Desktop
System in the following locations:

� On the accompanying Documentation CD.

Java Desktop System Release 2 Release Notes 11



� On http://docs.sun.com.

Accessing Localized Versions of User
Documentation
Some localized versions of the Java Desktop System user documentation do not
display in the GNOME Help browser. You can view localized versions of the user
documentation on the accompanying Documentation CD or on
http://docs.sun.com.

Perform the following steps to view the localized versions of the user documentation
from the Documentation CD:

� Insert the Documentation CD into the CD drive of your system.

� Open the README.html file with your HTML browser.

� Follow the instructions in README.html to select the language, topic, and manual
that you require.

Perform the following steps to view the localized versions of the user documentation
from http://docs.sun.com.

� Open the following page:

http://docs.sun.com

� Select the language that you require from the language selection buttons.

The language selection buttons are located next to the Search/browse within area
of the page.

� Enter the name of the manual that you want in the Search field.

� Choose the manual that you want from the list displayed.

Unsupported Documentation
This release of the Java Desktop System includes applications that have Help manuals
provided by the GNOME free software community. Documentation provided by the
free software community is not supported by Sun Microsystems. Sun Microsystems
does not take any responsibility for the completeness or accuracy of Help manuals
provided by the free software community. The following table indicates the extent of
Sun-supported documentation viewable in the Java Desktop System Help browser.
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Help Section Supported Status

GNOME Desktop Sun Microsystems provides documentation for all
supported applets and applications. Sun Microsystems
does not provide any documentation for unsupported
applications. See the following sections for lists of
unsupported applications:
� “Unsupported Applications” on page 20
� “Unsupported Third Party Applications” on page 21
� “Unsupported Games” on page 21

Additional documents � System
Sun Microsystems does not support any documents
in this section.

� Manual Pages
Sun provides 129 man pages related to supported
applications and functionality. If Sun Microsystems,
or an agent of Sun Microsystems, is not specifically
credited as the author of a man page, then the
document is not supported by Sun Microsystems.

� Info Pages
Sun Microsystems does not support any documents
in this section.

Sun Microsystems does not provide localized versions of unsupported documentation.

Plugins for Mozilla 1.4
This section contains information about plugins for Mozilla 1.4.

Java Plugin
Java Plugin is enabled in Mozilla 1.4 by default. If Java Plugin does not work, then
create a symbolic link in the /usr/lib/mozilla/plugins directory, pointing to the
following file:

$JAVA_PATH/plugin/i386/ns610-gcc32/libjavaplugin_oji.so

Note – Do not copy the libjavaplugin_oji.so file instead of creating a symbolic
link. A copy of the file causes Java to crash.
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Install all Java plugins in the /usr/lib/mozilla/plugins directory.

Other Plugins
The following third-party plugins are also available for Mozilla 1.4:

� Adobe Acrobat Reader
� Macromedia Flash Player
� RealPlayer

For more installation information about Mozilla plugins, see the following location:
http://plugindoc.mozdev.org/linux.html

Ximian Evolution 1.4 FAQ
The following table provides answers to some Frequently Asked Questions (FAQs) in
relation to Ximian Evolution 1.4.

Question Answer

How do I configure Pilot settings? Refer to the Pilot Configuration Help for information
about PalmOS synchronization and related settings.

How do I access Pilot from
Evolution?

Choose Tools → Pilot Settings.

Must I keep the Pilot Settings
dialog open during
synchronization?

No, but you must ensure that the gnome-pilot process
is active and functions properly.

Which types of PalmOS are
supported by Pilot in Evolution?

PalmOS 5 series.

I cannot connect to my PalmOS
device. Why not?

Check file permissions. The PalmOS device does not work
by default. Ensure you choose a device that you can use.
For example:

ttyUSB0 for USB, or ttyS0 for serial cradle.

Can PalmOS work with Evolution
through the USB device on the
Java Desktop System?

Yes, but using PalmOS through USB severely degrades the
performance of your personal computer (PC).
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Question Answer

Are there any risks during
synchronization through USB?

During synchronization, your PC might become
immobilized. For example, the Caps Lock LED and Scroll
Lock LED blink. Possible reasons are related to the USB
module, kernel problem, and hardware issues.

How do I backup PalmOS data to
a PC?

From the Pilot Settings dialog, select the Conduits tab
and enable the Backup option.

How can I copy backup files from
a PC to PalmOS using Evolution?

Pilot can restore your backup data from PC to PalmOS.
You can also use some command line tools such as:
gnome-pilot-install-file/pilot-xfer.

Does Evolution support the
category synchronization?

Evolution Conduits do not support category
synchronization.

Can I synchronize data between a
Java Enterprise System account to
a PalmOS device?

Yes, you must set the default calendar and task folder to
Java Enterprise System folders. From Evolution, choose
Tools → Settings →Folder Settings → Default Folders.

How does Evolution synchronize
with a PalmOS device?

Evolution does not communicate directly with PalmOS.
Evolution uses Conduits which also acts as a plugin for
Pilot and Pilot communicates with the PalmOS device.

Can I synchronize data from
Evolution to a Pocket PC?

No, you cannot synchronize Evolution with a Pocket PC
directly. But you can use other open source tools, such as
Sync and MultiSync to synchronize the address book of
Evolution.

How can I configure Mozilla so
that Evolution does not launch
when I click on Send Link or Send
Page?

Open one of the following files:
� $HOME/.mozilla/<profilename>/<random>/prefs.js
� /usr/lib/mozilla-1.4/defaults/pref

You must change the following line:

pref("network.protocol-
handler.external.mailto", true)

Change the line to the following:

pref("network.protocol-
handler.external.mailto", false)

How can I correct the protocol
settings for Java Enterprise System
accounts using Evolution?

If your Java Enterprise System server uses http protocol,
but you mistakenly choose https protocol in the Java
Enterprise System account settings, Evolution does not
allow you to correct the protocol from Settings.

As a workaround to this issue, right-click on the
Java Enterprise System folder and choose Forget
Password from the menu. Restart Evolution and cancel
the Enter Password dialog. Now you can choose the
correct protocol in Settings.
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Question Answer

Can I use Evolution with the CDE
Calendar application?

No, Evolution can only be connected to the Java
Enterprise System calendar server.

Migration To Unicode Multilingual
Computing
The Java Desktop System is a fully Unicode-enabled, multilingual system that
supports languages with Unicode UTF-8 encoding. The Java Desktop System also
provides codeset conversion to support legacy language encodings.

Legacy Language Options
The language selection menu in the login screen only shows the supported Unicode
UTF-8 language names instead of locale names. To support the migration to Unicode,
the Java Desktop System provides legacy locales using non-UTF-8 locales that system
administrators can add to the login selection menu as an option.

The list of languages shown in the language selection menu in the login screen is
configured in the following file: /etc/X11/gdm/locale.alias

Each supported legacy locale is listed in this file in a commented out line preceded by
the # character. For example, Japanese support is listed in the following way:

Normal Line Commented Line

Japanese ja_JP.UTF-8 #Japanese ja_JP.eucJP

To show ja_JP.eucJP as an option in the language selection menu, open the
locale.alias file with a text editor and remove the # character at the start of the
line.

Importing And Exporting Data
There are a number of methods of importing and exporting data that are affected by
the migration to Unicode multilingual computing.
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Removable Media
The system administrator must configure the mount options codepage and
iocharset for the file system type FAT and VFAT that are typically used for floppy
disks, zip drives, and removable hard-disks on Microsoft Windows. For example, if
you import from Traditional Chinese Windows, the settings must be as shown in the
following table to browse the traditional Chinese filenames correctly.

Mount Option Traditional Chinese Setting

codepage 950

iocharset big5

Sample entries for /etc/fstab for the Traditional Chinese example are as follows:

/dev/fd0h1440 /media/fd0h1440 vfat
noauto,iocharset=big5,codepage=950

/dev/sda1 /media/iee1394disk vfat
noauto,iocharset=big5,codepage=950

Mounting a Remote Microsoft Windows File System Using
Samba
A system administrator must configure mount options codepage and iocharset to
mount a remote Microsoft Windows file system shared using CIFS, or a file system
exported from another system by SMB. For example, if you import the legacy files
encoded in big5 on Traditional Chinese Windows, the iocharset parameter must be
set to big5 and codepage must be set to 950 to browse the Traditional Chinese file
names correctly. A sample /etc/fstab entry is as follows:

server:/data /data smbfs
iocharset=big5,codepage=950,username=foo,password=bar

Mounting a Remote UNIX File System Using Samba
The Java Desktop System can remotely access a file system on UNIX and Linux
systems by using SMB. The export server must run Samba or equivalent to export the
remote file system. The client side can specify file system encoding if the legacy data is
stored in legacy encodings. The codeset conversion of the filename is done
automatically.
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Microsoft Office Files
Microsoft Office files are encoded in Unicode. StarOffice applications can read and
write the Unicode encoded files without problem.

HTML Files
HTML files authored using HTML editors such as Mozilla Composer , or HTML files
saved by a web browser, usually contain a charset encoding tag. After exporting or
importing, you can browse such HTML files with the Mozilla Navigator web browser,
or edit the files with Mozilla Composer, according to the encoding tag in the HTML
file.

Fixing Broken HTML Files
Some HTML files might be displayed in garbage characters. This problem is typically
due to the following reasons:

� The charset encoding tag is incorrect.
� The charset encoding tag is missing.

To find the charset encoding tag in the HTML file, perform the following actions:

1. Open the file with Mozilla.
2. Press Ctrli, or click View to open the View menu.
3. Click on Page Info.

The charset information is in the bottom of the General tab, for example:
Content-Type text/html; charset=us-ascii

If the string charset=us-ascii does not match with the actual encoding of the file,
the file might appear as broken. To edit the encodings of the HTML file, perform the
following actions:

1. Open the file with Mozilla Composer.

2. Open the File menu.

3. Select Save As Charset.

4. Choose the correct encoding. Mozilla Compose automatically converts the
encoding and the charset tag as appropriate.

Emails Saved As Portable Format
Modern emails are tagged with the MIME charset tag. The mail application of the
Java Desktop System, Evolution, accepts MIME charset tags. You do not need to
perform any encoding conversion.
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Plain Text Files
Plain text files do not have a charset tag. If the files are not in UTF-8 encoding,
encoding conversion is needed. For example, to convert a plain text file encoded in
Traditional Chinese big5 to UTF-8, execute the following command: iconv -f big5
-t UTF-8 inputfilename > outputfilename

Supported Languages
The following table lists the supported languages for this release of the Java Desktop
System.

Supported Languages

English

French

German

Italian

Japanese

Korean

Spanish

Swedish

Simplified Chinese

Traditional Chinese

Note – Brazilian Portuguese is supported by the user interface only.
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Unsupported Applications
The following table describes applications in the Java Desktop System that are not
supported by Sun.

Unsupported
applications Description

Diagrams and
Flowcharts

Drawing diagram editor and charting tool.

Image Editor GNU Image Manipulation Program that enables you to edit images.

Digital Camera Digital camera utility that enables you to manage images.

Image Organizer Image viewer and browser that displays thumbnails of images on your
desktop.

Video
Conferencing

Real-time conferencing application.

Project Manager Project management and scheduling tool.

Movie Player Multimedia player that enables you to play motion pictures.

Text/Source
Editor

General purpose extensible editor for programmers.

Dictionary Online dictionary that enables you to look up definitions and correct
spellings of words.

Diagram Editor Diagram editor that enables you to create flow charts, maps, UML
diagrams, and many other diagrams.

Disk Analyzer Disk analyzer that enables you to visualize your disk.

Weather Report Displays current weather conditions for different regions.
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Unsupported Third Party Applications
The following table describes third-party products in the Java Desktop System that are
not supported by Sun.

Third Party Products Description

Adobe Acrobat Reader Enables you to view Portable Document Format (PDF) formatted
files.

Macromedia Flash Player Enables you to play back interactive multimedia on the Web.

RealPlayer Enables you to play back media files in a variety of popular
formats.

Unsupported Games
The following games are not supported by Sun Microsystems:

� Freecell
� GTali
� Gataxx
� Glines
� Gnect
� Gnibbles
� Gnotski
� Iagno
� Mahjongg
� Mines
� Robots
� Same GNOME
� Stones
� Tetravex
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Product Updates
You can download product updates of the Java Desktop System from the following
location: http://www.jdsupdate.sun.com

Customer Support
Sun Microsystems provides the following customer support services:

Location Description

http://www.sun.com/service/contacting/solution.html Technical Support
Centers

http://www.sun.com/service/support/warranty/ Global Warranty
Support

http://www.sun.com/service/support/software/desktop/index.html Software Support
Services

Installation and Configuration Support Agreement
An Installation and Configuration Support Agreement postulates that the Client has a
Standard Installation. A Standard Installation is an installation of the Sun Java Desktop
System Retail Product that only contains the packages that are included in the product
scope or are offered in the Maintenance Web.

An Installation and Configuration Support Agreement can only be executed for a
Standard Installation. The Client shall promptly inform the Supplier about any
modification of the Standard Installation performed by the Client after the submission
of the offer. If the Supplier does not accept the modification for the Installation and
Configuration Support or if the Client does not report the modifications, the Supplier
is entitled to terminate the Installation and Configuration Support on extraordinary
grounds as soon as the Supplier learns of the modifications.
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